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CATIA V5 Automotive - Powertrain Lesson 2: Profile Creation



Profile Creation



Student Notes:



In this lesson you will learn how to create a simple part.



Lesson Contents:



Copyright DASSAULT SYSTEMES



Case Study: Profile Creation Design Intent Stages in the Process Create a New Part Select Appropriate Sketch Support Create Sketched Geometry Constrain the Sketch Create Pad Feature Save and Close Documents



Duration: Approximately 0.5 day
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CATIA V5 Automotive - Powertrain Lesson 2: Profile Creation



Case Study: Profile Creation



Student Notes:



Copyright DASSAULT SYSTEMES



The case study for this lesson is the Timing Chain Cover used in the Front Suspension and Engine assembly as shown below. The Timing Chain Cover is a part of the Powertrain subassembly. The focus of this case study is the creation of a profile that incorporates the design intent for the part.
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Design Intent The Timing Chain Cover must meet the following design intent requirements: The model must be created in one feature. While this is not general practice, in this case it is a requirement.



The top angle must be 120 degree. Apply the angle constraint between the edge A and B.



The overall height must be 335mm. Apply distance constraint between the edge E and the vertex F. B



The angular side walls must be perpendicular to the top walls. Apply perpendicular constraint between edge B and D, and edge A and C.
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The center of convex circular arc must be 50mm from vertical reference and 120mm from horizontal reference.



D



F A



C



G



Apply distance constraint between edge E and point G, and vertical plane and point G.



The thickness must be 12mm. Length of pad must be 12mm.



The model must be saved with the name Timing Chain Cover.
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Stages in the Process



Student Notes:



The following steps will be used to create the Timing Chain Cover : Create a new part. Select an appropriate sketch support. Create sketched geometry. Constrain the sketch. Create the pad feature. Save and close the document.
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1. 2. 3. 4. 5. 6.
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Create a New Part In this section you will learn about part design and how to create a new part file.



Use following steps to create the Timing Chain Cover: 1. Create a New Part.
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2. Select an Appropriate Sketch Support. 3. Create Sketched Geometry. 4. Constrain the Sketch. 5. Create the Pad Feature. 6. Save and Close the Document.
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Creating a New Part 1a



When creating a new model, the Part Design workbench is activated. When a part is saved, it is saved with a .CATPart extension to distinguish it from other CATIA documents. Use the following method to create a new part file: 1. Use any of the following: a.



b. c.



Click Start > Mechanical Design > Part design. Click File > New and select Part from the New dialog box. Select the New icon from the Standard toolbar and select Part from the New dialog box.



1b



2. Specify a name for the part. 3. Click OK.



2
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1c



3



To ensure that you respect company standards when designing a new model, you can also start a new model from an existing template which is already compliant with these standards:
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Part Design Workbench



Student Notes:



Copyright DASSAULT SYSTEMES



A new part contains only three default reference planes. These default reference planes are always the first elements in the specification tree and are used as a basis for feature creation.
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Select an Appropriate Sketch Support



Student Notes:



In this section you will learn what is a sketch support and how to select an appropriate sketch support.



Use following steps to create the Timing Chain Cover: 1.



Create a New Part.



2.



Select an Appropriate Sketch Support.



Create Sketched Geometry. Constrain the Sketch. Create the Pad Feature. Save and Close the Document..
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3. 4. 5. 6.
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Reference Planes The default reference planes are the first three features in any part file. Their names are derived from the plane they are parallel to, relative to the part coordinate system:



B



C A



A. XY plane B. YZ plane C. ZX plane
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The reference planes provide a support on which the first sketch is created.
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Profile is sketched on the ZX plane.
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What is a Sketch?



Student Notes:



Every new part begins with a 2D profile. This profile can be created using the Sketcher workbench.



The Sketcher workbench is a 2D workspace. The elements created within Sketcher are exclusively 2D WIREFRAME elements.
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In the Part Design workbench, the geometry created in Sketcher is seen as a single sketch. This sketch is used to create 3D features inside the Part Design workbench.



Sketches are constrained so that they can be quickly modified by simply altering dimensions.
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Sketch Support (1/2) Sketch support



A sketch support is the plane on which the sketch is created. The sketch support must be planar. Sketch



You can create a sketch on a reference plane or on a planar face of any existing geometry.
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Typically, the first feature in the model is created on one of the default reference planes.
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Sketches can be extruded to create solid geometry.
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Sketch Support (2/2) The default orientation of the model depends on which reference plane is selected for the sketch support.



Profile sketched on the XY plane



The YZ plane is considered the front view of the part, as defined by the quick views discussed in Lesson 1. When selecting the sketch support, consider the orientation of the profile that you are creating.



Profile sketched on the YZ plane



For example, you have to select a different sketch plane if you are creating a side profile, as opposed to a front profile for the 3D geometry.
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Profile sketched on the ZX plane
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Create Sketched Geometry In this section you will learn how to access the Sketcher workbench and how to create sketched geometry.



Use following steps to create the Timing Chain Cover: 1. 2.



3.



Create Sketched Geometry.



Constrain the Sketch. Create the Pad Feature. Save and Close the Document.
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4. 5. 6.



Create a New Part. Select an Appropriate Sketch Support.
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Basic Sketching



1



Sketched profiles are created inside the Sketcher workbench. Use the following steps to access the Sketcher workbench within another workbench: 1. Select a planar sketch support. 2. Select the Sketcher icon from any workbench where it is possible to create a sketch (such as the Part Design workbench), or click Start > Mechanical Design > Sketcher. 3. CATIA opens the Sketcher workbench.



2
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3
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Positioned Sketching Positioned sketches are created inside the Sketcher workbench. Use the following steps to create positioned sketch and access the Sketcher workbench within another workbench: 1. Select the Positioned Sketch icon from any workbench where it is possible to create a sketch. (such as the Part Design workbench) 2. Sketch positioning window appears. a. Sketch is positioned according to Reference plane. b. Origin of the sketch is positioned according to Origin Reference. c. Orientation of the sketch is defined according to orientation type. d. Orientation of the sketch can be further managed using the check buttons.



1



2a



2b



3. CATIA opens sketcher workbench.



Step 3 - Create Sketched Geometry



2c



The support can be modified by accessing the contextual menu of the sketch (Sketch.x object > Change Sketch Support). The edition of the sketch support gives the same dialog box in which the parameters can be modified.



2d



The advantages of using a Positioned sketch will be described later.
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Sketcher Workbench The Sketcher workbench is an environment built to facilitate the creation of the 2D Profiles. The workbench includes the following key features: D C



A



B
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A. The Grid, which guides you while you create the profiles. B. The Profile toolbar, which is used to create geometry. C. The Constraint toolbar, which is used to dimension and constrain your sketch. D. The Sketch Tools toolbar, which is a floating toolbar (default) that displays options available during geometry creation. The options within this toolbar vary depending on the geometry being created.
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Grid By default, a grid is applied to the background of the Sketcher workbench. This grid helps define the scale of sketched entities. When sketching, the mouse pointer snaps to the points of the grid. This functionality can be made unavailable temporarily by deactivating the Snap to Point icon.



Snap to Point Inactive Snap to Point Active



Options for the grid can be controlled in Tools > Options > Mechanical Design > Sketcher. You can: A. Toggle the display of the grid. B. Permanently activate/deactivate the Snap to Point option. C. Change the values for both the Primary spacing and Graduations.



A



C



B



Graduations
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Primary Spacing



Copyright DASSAULT SYSTEMES



2-17



CATIA V5 Automotive - Powertrain Lesson 2: Profile Creation Student Notes:



Geometry Creation Sketched geometry is created using the tools available in the Profile toolbar:



A B



A. B. C. D. E. F. G. H.



User-Defined Profile Pre-defined Profiles Circles Splines Ellipses and Parabolas Lines Axes Points



C D E F G H



The Operation toolbar can be used to modify existing sketched geometry. In this lesson, you will learn how to use the following relimitation tools: I J
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I. Corners J. Chamfers
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Points Description



Point by Clicking



Create a point by clicking locations on the sketch.



Point by Coordinates



Create a point by defining its coordinates in the 2D space of the sketch.



Equidistant Points



Create as many points as required, which are distributed equidistantly on an existing curve. Once created, the points are considered separate entities.



Intersection Point



Create the intersection point between two existing curves.



Projection Point



Project an existing point onto an existing curve. The projection can be normal to the curve or along a direction.
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Icon
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Lines



Copyright DASSAULT SYSTEMES



Icon



Geometry



Description



Line



Create a line by clicking two points to define its extremities.



Infinite line



Create an infinite line by clicking two points to define its direction.



Bi-tangent line



Create a line tangent to two existing curves.



Bisecting Line



Create a line bisecting two existing lines.



Line Normal to Curve



Create a line normal to an existing curve. Create the line by selecting an endpoint and the curve the line is to be normal to.



A Sketcher element is based on points. As a result, each time you create geometry in the Sketcher workbench, points are implicitly created. Sketched geometry is added to the specification tree under the Geometry branch of the sketch.
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Circles



Copyright DASSAULT SYSTEMES



Icon



Geometry



Description



Circle



Create a circle by defining its center and its radius.



Three Point Circle



Create a circle passing through three points.



Circle by Coordinates



Create a circle by giving the coordinates of its center relative to the sketch origin and its radius.



Tri tangent Circle



Create a circle tangent to three existing curves.



Three Point Arc



Create an arc passing through three points, relimited by the first and the last selected points.



Three point arc starting with limits



Create an arc passing through three points, relimited by the first and the second selected points.



Arc



Create an arc by defining its center and the two limit points.
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Ellipse, Parabola, Hyperbola, and Spline Icon



Geometry



Description



Ellipse 1



2



Create an ellipse by selecting its center point, then defining its major and minor diameter by clicking two points.



3



• • • •



Parabola by Focus 1



2



3



4



Hyperbola by focus 1



2



4



3



5



Spline
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1
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2



3



4



5



• • • •



Create a Parabola by selecting: Focus point Summit Relimiting points (endpoints) Create an Hyperbola by selecting: Focus and center points Summit Relimiting points (endpoints)



Create a spline curve passing through as many points as required. End the spline by double-clicking.
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Conics After the Conic icon is selected, several tools appear in the Sketch Tools toolbar that contol its creation.



Icon



Geometry



Two point conic with end tangents



Description 4



2 5 1



Two point conic with tangent intersection
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Four point conic with one tangent



3 4



1



2



2



5 1



4



4 3



• Create by selecting: • Two endpoints • A point which defines the tangent intersection • A mid-point • Create by selecting: • Two endpoints • Two midpoints and define one tangency at the first or last point 3



5



1



Five point conic
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3



• Create by selecting: • A first endpoint and define its tangency • A second endpoint and its tangency • A mid-point



2



• Create by selecting: • Two endpoints • Three mid-points
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Pre-defined Profiles (1/2) Icon



Geometry



Rectangle Oriented Rectangle



Parallelogram



Elongated Hole
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Cylindrical Elongated Hole



Description



1



Create a rectangle by clicking its two opposite corners.



2



1



2



3



1



2



3



1



2



3



1



2



3



Create a rectangle by defining two consecutive corners to define its orientation, and a third corner to give it a thickness. Create a parallelogram by defining two consecutive corners, and a third corner to give it thickness and angle. Create an elongated hole by defining a segment as its axis, and defining its thickness. 4



Create a cylindrical elongated hole by defining an arc as its axis, and defining its thickness.



Conf. Dep.
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Pre-defined Profiles (2/2) Icon



Geometry



Keyhole Conf. Dep.



1



2



Hexagon



3



Centered Rectangle



3 2 1



Create a keyhole by defining the center of the large circle, the radius of the large circle, the center of the small circle, and the radius of the small circle. Create a hexagon by defining its center and a point on the hexagon. Create a centered rectangle by defining its center and two points to define its height and width.



2



1



Centered Parallelogram



4



2



1



Conf. Dep.
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Description



Create a centered parallelogram select the first line, select the second line and click to define its dimensions. The parallelogram is centered on the intersection of the two lines. Its edges are parallel to the selected lines.



Once created, pre-defined profiles are divided into elements. For example, a rectangle is divided into four lines and four points (located at the corners).
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User-defined Profiles Use the following steps to create a profile:



Step



Geometry



Description



1. Start the profile. Line



Three Point Arc



2. Create the profile.



Line



Three Point Arc



You can go on with the profile using segments (Line option), tangent arcs (Tangent arc), or non-tangent arcs (Three points arc). End a closed profile by selecting the first point. End an open profile by double-clicking.
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3. End the profile.



Tangent Arc



The profile can start with a segment using the Line option, or with an arc using the Three points arc option.
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Introduction to Re-limitations Icon



Geometry



Description Create a corner shape between the two selected lines.



Chamfer



Create a chamfer between the two selected lines.
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Corner
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Construction Geometry Construction geometry is created within a sketch to aid in profile creation. Unlike standard sketched geometry, construction geometry does not appear outside the Sketcher workbench. A sketched element is created as a construction element when the Construction/Standard Element icon (located in the Sketch Tools toolbar) is highlighted. Construction geometry is created using the same techniques as standard sketched geometry, and is distinguished from standard elements by its dashed format.



Construction geometry
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In this example, the construction of a symmetrical shapes was aided by the use of construction geometry.
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Recommendations for Sketching



Student Notes:
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In this section, you will be given some recommendations to help during the creation of sketches.
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Why Positioned Sketch? (1/4) It is recommended to use a Positioned Sketch when creating a sketched profile. 1.



It enables you to define explicitly the origin and the orientation of the sketch. a. Select the face; the position of the origin is Implicit b. Select the Type of Origin – Intersection 2 lines c. Select the reference data – the 2 edges of the angled face



1a
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1c
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1c



1a 1b
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Why Positioned Sketch? (2/4) 2. You can manage the orientation of the sketch when entering the Sketcher workbench. a. Select Swap to inverse the H and V axes b. Select Reverse V to reverse this axis c. Click OK to enter the Sketcher workbench and see the required orientation



2a



2a
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2c
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2b



2b 2c
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Why Positioned Sketch? (3/4) The sketch elements will be positioned with reference to the sketch axes rather than elements which are external to the sketch. This ensures stability of the sketch profile if the sketch support is modified. 1. In the example shown 2 sketches are initially superposed. a. The green dotted line indicates the Positioned Sketch (Sketch.2) whose origin is at bottom corner of the angled face. b. The blue solid line indicates the Sketch (Sketch.3) whose origin is on the edge of the angled face.



1
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2. The height of the right vertical wall is reduced and the angled face is modified a. The Positioned Sketch (Sketch.2) remains correctly positioned with respect to its origin and the face b. The Sketch (Sketch.3) remains positioned correctly with respect to its origin BUT will slide on the angled face
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2b 2a
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Why Positioned Sketch? (4/4)



Student Notes:
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If it is necessary the sketch can be more easily repositioned with respect to another reference by redefining the reference face and the origin type.
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Creating a Profile: Which are the Best Tools to Use? When creating a sketched profile, many tools can be used. Two frequently asked questions are: • •



Which are the best tools to use? How complex should sketches be?



1 You could create individual lines, then use the trim tool to create the final shape required.



It is often more efficient to create the shape using the Profile tool (or the Predefined Profile tools). Consider using individual points or only lines when you need to complete or modify a shape.



2 Click



Click



Click
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Click



Click Click
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When to Use Fillet, Chamfer, Draft? (1/2) It is recommended not to use Fillets, Chamfers and Drafts when creating sketched profile, because some of the manufacturing processes need to remove the Dress-Up features.



Student Notes:



A
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A. Create simple sketches and add the corners and chamfers afterward – it takes more time to update this kind of feature; however, corners and chamfers can be easily reordered, deactivated, or suppressed if necessary.
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When to Use Fillet, Chamfer, Draft? (2/2) B. Differentiate between a mechanical radius and a style radius. Purpose of mechanical radius is to remove sharp corners and the purpose of style radius is functional/style requirement. Style radius can be included in the profile definition.



Student Notes:



B
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B



R32 and R75 are style radius, and Both R10 are mechanical radius.
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R12, R8 are style radius, and both R5 are mechanical radius.
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Exercise: Profiles Creation



Student Notes:



Recap Exercise 15 min



In this exercise you will construct various geometric elements in the Sketcher workbench. This exercise will help you to understand the sketcher tools and to get a better feel of the Sketcher workbench. You will create sketches without worrying about constraints. Detailed instructions for this exercise are provided. By the end of this exercise you will be able to: Create a new part Access the Sketcher workbench Create lines, pre-defined profiles, user-defined profiles, and chamfers
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Close a file without saving it
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Do it Yourself (1/9) 1. Create new part. Select Part in the New dialog box to create a new part file. a. b. c. d.



Select File > New. Choose Part in the New dialog box. Click OK. Keep the default name and click OK.



1b



2. Launch the Sketcher workbench. Sketches are created in the Sketcher workbench. It is accessed by clicking a Positioned Sketch icon. a. Select XY plane as the Reference. b. Select the Part origin as the Origin. c. Select Y Axis as the Orientation.



1d



1c



2



2a 2b
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2c



Copyright DASSAULT SYSTEMES



2-38



CATIA V5 Automotive - Powertrain Lesson 2: Profile Creation Student Notes:



Do it Yourself (2/9) 3. Turn off Automatic constraints. Constraints will be taught in the next section; deactivate them for now. a. Ensure that the Geometrical constraint icon is not highlighted. If it is, click on it to deactivate it. b. Ensure that the Dimensional constraint icon is not highlighted. If it is, click on it to deactivate it.



4. Create a rectangle. The first shape is a rectangle. Create the sketch using the pre-defined profile tool for rectangles.



3a



3b



Ensure that Geometrical and Dimensional constraints are not highlighted, as shown.



4a



4b
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a. Click the Rectangle icon in the Profile toolbar. b. Click anywhere on the screen to fix the top left corner of the rectangle. c. Drag the cursor down and to the right, click again to fix the lower-right corner of the rectangle.
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4c
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Do it Yourself (3/9)



5a



5. Create a chamfer. Add a chamfer to the profile using a relimitation tool. a. Click the Chamfer icon in the Operation toolbar. Notice that the Sketch Tools toolbar expands to display the tools available for chamfer creation. b. Select the left edge of the rectangle. c. Select the upper edge of the rectangle. d. Place the chamfer by dragging the cursor to the desired location and clicking the left mouse button.



5b



5c
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5d
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Do it Yourself (4/9) 6.



Create a circle. Sketch the next shape using the Circle icon. a. b. c.



7.



b. Copyright DASSAULT SYSTEMES



Click the Circle icon in the Profile toolbar. Click a point on the screen to define the center of the circle. Drag the cursor outwards to define the radius of the circle and click the left mouse button to fix it.



Create a line profile. Sketch a horizontal line using the Line icon. a.



c.



6a



Click the Line icon in the Profile toolbar. Click on the screen to define the starting point of the line. Drag the cursor in the required direction and click another point to define the end of the line.
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6b



6c



7a 7b



7c
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Do it Yourself (5/9) 8.



Create a keyhole profile. 1. Add a pre-defined keyhole profile using the Keyhole Profile icon. a.



b. c.



d.
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e.



Click the Keyhole Profile icon in the Profile toolbar. Look at the message bar and notice that it prompts you for the inputs required to create the feature. Click anywhere on the screen to define the center of the larger circle. Drag the cursor downwards and click another point to define the center of the small radius. Drag the cursor horizontally outwards to define the radius of the smaller circle and click the left mouse button to fix it. Once again drag the cursor horizontally to define the radius of the larger circle and click the left mouse button to fix it.
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8a 8b



8c



8e 8d
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Do it Yourself (6/9) 9.



Create a user-defined profile. Create a user-defined profile using the Profile tool. a. b.



c.



d.
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e.



Click the Profile icon in the Profile toolbar. Notice that the default icon selected in the Sketch Tools toolbar is Line. Click anywhere on the screen to define the starting point of the line and drag the cursor. Drag the cursor and click another point on the screen to define the end of the line. Create an arc that is tangent to the line by clicking the Tangent Arc icon. Drag the cursor down to define the radius of the arc and click the left mouse button to complete the arc. Notice that the profile toolbar defaults back to the Line tool.
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9a



9b



9c



9e



9d
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Do it Yourself (7/9) 9.



Create a user-defined profile (continued). f. g. h. i.



9f



Create another line, as shown. Close the profile by clicking the Three Point Arc icon. Click a point (as shown) to define the second point of the arc. Click on the start point of the profile to complete the arc. Notice that the Profile tool automatically completes. 9h
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9i
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9g
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Do it Yourself (8/9) 10. Create a construction line. • Convert the existing geometry into construction elements using the Construction/Standard Element tool. a.



b.



c. d.



Select on the four segments of the profile (press and hold the key to select multiple items). Click the Construction/Standard Element icon in the Sketcher Tools toolbar. Click anywhere on the screen to deselect the geometry. Click the Construction/Standard Element icon once again to deactivate the tool.



10a



10b



10c
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10d
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Do it Yourself (9/9) 11. Create additional geometry. • Use appropriate tools to create the geometry shown below. 12. Close the sketch. a. b. c.
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11



Click Exit workbench icon. Click File > Close. Click No to the information message dialog box.
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12a



12c
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Exercise Recap: Profiles Creation



Student Notes:



Create a new part file Select the XY plane as sketch support Create sketch geometry
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Close the document without saving
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Exercise: Profile Creation



Student Notes:



Recap Exercise 15 min



In this exercise you will create a sketched profile. High-level instruction for this exercise is provided.



By the end of this exercise you will be able to: Create a new part Access the Sketcher workbench Create geometry using the Profile tool Create a corner Copyright DASSAULT SYSTEMES



Close the document without saving it



Copyright DASSAULT SYSTEMES



2-48



CATIA V5 Automotive - Powertrain Lesson 2: Profile Creation Student Notes:



Do it Yourself 1. Create a new part. 2. Create a Positioned Sketch using YZ plane as the Reference plane and access the Sketcher workbench.



2



3. Ensure that the automatic constraints (located in the Sketch Tools toolbar) are deactivated. 4. Create the profile (as shown) using the Profile icon.



3



4



5. Create the corner (this is a Style type of radius). 6. Close the document without saving it.
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5
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Exercise Recap: Profile Creation Create a new part file Select the YZ plane as the sketch support Create sketched geometry
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Close the document without saving it
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The sketch created in this exercise could be used to create a revolved feature, as shown above. You will learn how to create revolved features in Lesson 4.
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Exercise: Profile Creation



Student Notes:



Recap Exercise 10 min



In this exercise you will create five profiles. You will use the tools learned in the previous exercises to complete this exercise.



By the end of this exercise you will be able to: Create a new part Create positioned sketch profiles using ZX plane as sketch support
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Close the document without saving it



CAUTION: Generally, for complex parts it is recommended that you simplify the sketches using dedicated 3D features like fillets, chamfers, holes, drafts, etc. to better fit the design and manufacturing intents.
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Do it Yourself 1. Create a new part and create five different profiles as shown, using Positioned Sketch and ZX plane as the sketch support. 1



3



5
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4



2
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Exercise Recap: Profile Creation



Student Notes:



Create a new part file Access Sketcher workbench Create positioned sketch geometry using ZX plane as sketch support Close the document without saving it



You can create the outside profile using a number of ways:
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Create the profile using a series of lines and arcs. Create the whole profile using the Profile tool.
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Constrain the Sketch In this section you will learn how to constrain the sketch using geometrical and dimensional constraints.



Use following steps to create the Timing Chain Cover: 1. 2. 3.



4.



Constrain the Sketch.



Create the Pad Feature. Save and Close the Document.
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5. 6.



Create a New Part. Select an Appropriate Sketch Support. Create Sketched Geometry.
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Constraining the Sketch Once the sketched geometry is created, dimensions and geometric constraints can be added. Constraints serve to mathematically fix geometry in space. Without constraints, geometry can be moved using the mouse. If the sketched profile is moved, the solids that are supported by them are also moved. In the context of an assembly, if one part moves, another part that is related to it may also move.
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Without constraints, feature creation becomes unpredictable and modifications to a model may adversely affect form, fit, and function of entire assemblies. Constraints are used to specifically relate one element to another, and to itself, in a logical way.



Movement of four Unconstrained Lines



After Constraints are created, they can be modified by changing their values or placement. From the ease at which constraints may be modified and from the inherent downstream associativity of CATIA V5, the user can quickly explore alternative designs while still maintaining design intent.
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Geometric and Dimensional Constraints Constraints are added to sketched geometry in the Sketcher workbench. Two types of constraints can be added to sketched geometry: A



A. Geometric constraints, which specify how sketched elements are positioned with respect to each other and existing 3D geometry. B. Dimensional constraints, which specify the distance between two elements. This distance can be linear, angular, or radial, depending on the type of geometric elements involved.



Geometric constraint (here concentricity)



B



These constraints can be set using the icons on the Constraint toolbar: C. Constraint Defined in Dialog Box



Dimensional constraint (here distance)
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D. Constraint
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C



D



Conf. Dep.
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Fully-Constrained Sketches Ideally, a completed sketch must be fullyconstrained. The size and location of the sketch must be clearly defined. An under-constrained sketch may not maintain design intent when modifications are made to the model. Constrained sketches allow you to fully use the associative and parametric capabilities of CATIA.



The sketch for the cut is not constrained. When modifications are made to the solid, the cut does not stay in the correct location.



The constrained status of a sketch is indicated by its color: •



•
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• •



Green indicates that the sketch is fullyconstrained. The geometry is fixed and cannot be moved without changing dimensional values. White indicates that the sketch is underconstrained. Some degrees of freedom still remain. Purple indicates that the sketch is overconstrained. There are too many constraints. Red indicates that the constraints of the sketch are inconsistent. The sketch cannot be updated using the current constraints.
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The sketch for the cut is fully-constrained. When modifications are made to the solid, the cut stays in the correct location.
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Geometric Constraints (1/2) Description



Fix



A fix element cannot be modified.



Coincidence



Makes a point of an element coincident with another element.



Concentricity



Makes two arcs concentric.



Tangency



Set tangency continuity between two elements.



Parallelism



Makes two lines parallel. Select the line to remain fixed first and then select the line to be made parallel to the first.
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Representation



Student Notes:
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Geometric Constraints (2/2) Description



Perpendicularity



Makes two lines perpendicular.



Horizontal



Makes a line horizontal (parallel to the H axis of the sketch).



Vertical



Makes a line vertical (parallel to the V axis of the sketch).



Symmetry



Makes two lines symmetric about a selected element. Select the two outer lines first and then the element they are to be symmetric about.



Copyright DASSAULT SYSTEMES



Representation



Student Notes:
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Dimensional Constraints Description



Distance



The distance between two elements is calculated.



Length



The length of the constrained element is calculated.



Angle



Calculates the angle between two non- parallel lines.



Radius/Diameter



Gives the radius or the diameter of a circle or an arc.
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Representation



Student Notes:
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Recommendations for Constraining



Student Notes:
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In this section, you will be given some recommendations to help while constraining the sketches.
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Sketch in Context (1/2)



3D geometry used to sketch and constrain profiles
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To sketch in context means to use existing geometry to create new geometry. When sketching, always keep in mind your design intent and dimension and constrain your sketch accordingly. Use existing model elements to constrain your current sketch. For instance, the pocket shown below needs to stay 15 mm away from the right side of the base feature. By dimensioning the sketch to the right side of the base feature this design intent can be maintained even when the base feature’s dimensions are changed.
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Sketch in Context (2/2) It is recommended not to use Dress-Up features for sketch in context. Some of the manufacturing processes need to remove Dress-Up features, also Dress-Up features are more likely to get reordered and deactivated. 1.



In the example shown, Sketch.2 is in context of edge of EdgeFillet.1. a.



2.



1



If EdgeFillet.1 is deactivated or deleted, Sketch.2 goes in error.



The sequence of priority to select existing element for sketch in context could be1a
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a. Fixed elements, such as XY, YZ, ZX planes. b. Other sketch element. c. Face of a 3D element. To be avoidedd. Edge of a 3D element.



Copyright DASSAULT SYSTEMES



2-63



CATIA V5 Automotive - Powertrain Lesson 2: Profile Creation



Sketcher Orientation (1/2)



Student Notes:



It is recommended that the screen be oriented parallel to the sketching plane you are in, while creating sketched geometry. By default, this will happen automatically. When you exit the Sketcher workbench, the screen will immediately return to the previous 3D orientation. By default, all geometry in 3D space is available while you are in the Sketcher workbench. This means it is possible to constrain 2D sketcher geometry to features not in the same sketch or even the same sketch plane.
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When constraining sketched geometry to existing 3D elements it is a good idea to rotate the model into a 3D view. By rotating the model you can ensure that the correct 3D element is selected. Once the 3D element is highlighted select the Normal View icon to return the orientation parallel to the sketching plane.
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Sketcher Orientation (2/2) When constraining to the edge of the part, if you view the sketch in a normal view, CATIA creates the constraint to the “first” edge. A better alternative is to rotate the sketch and select a more stable feature (such as the face of the part), and not the edge.



Original Part



Copyright DASSAULT SYSTEMES



Constraint created in Normal view uses the edge and not the face as intended.



Once you have finished selecting references, use the Normal View icon to orient the screen parallel to the sketch support again.
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Rotate the model to ensure that the top surface is selected and not the edge of the fillet.
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Tips on Initial Sketch Geometry (1/2) Initial Size of Sketch: •
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•



As you begin to create geometry, try to create it reasonably close in shape and size to the final constrained sketch. A sketch that greatly differs from the required profile will become distorted when the final dimensional constraints are applied. This will make it difficult to fully constrain the sketch.



Initial Sketch



Consider using the grid to help maintain proper scale for sketched elements.



Observing the values in the Sketch Tools toolbar will help you understand the real size of the elements being sketched.
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Final Sketch
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Tips on Initial Sketch Geometry (2/2)



Student Notes:



The Geometrical Constraints icon (located in the Sketch Tools toolbar) controls whether or not geometric constraints are automatically created during the development of the initial sketch.
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This tool is useful to use with simple geometry, because it helps speed up the finalization of the shape. With more complex geometry, however, using this tool selected may lead to the creation of unwanted constraints.
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Tips on Constraint Creation You can use two tools to define the constraints on a sketch, as shown on the right. Both create geometric and dimensional types of constraints.



Geometric Constraints



Dimensional Constraints



As you become more skilled, it is more efficient to use the process below to create constraints:



Double-click this ICON.
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Selecting geometry creates dimensional constraints.
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Selecting geometry, then right-clicking creates geometric constraints.
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Controlling the Constraint Dimension Direction



Student Notes:



When creating a dimensional constraint on a profile, the dimension direction is determined by the type of element selected. If the elements are points or circles, the default dimension direction is parallel to the line between the points or circle centers.
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When creating a dimension constraint between two circles or points, you can force a horizontal or vertical dimension orientation by right mouse clicking and choosing the required orientation.
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Create the Pad Feature In this section you will learn how to create a simple base feature. You will gain advanced skills for feature creation in the subsequent lessons.



Use following steps to create the Timing Chain Cover: 1. 2. 3. 4.



5.



Create the Pad Feature.



Save and Close the Document..
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6.



Create a New Part. Select an Appropriate Sketch Support. Create Sketched Geometry. Constrain the Sketch.
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Completing the Feature Once the sketched profile has been created, solid 3D geometry can be generated from it.



Extruded pad
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2D profile (sketch)
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Using a Pad to Create the First Feature Use the following steps to create a pad that will be used as the first feature in a model:



1



1. Select the profile sketch to be used for the Pad. 2. Select the Pad icon. 3. Specify length.



2



4. Complete the feature.
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3
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Save and Close the Document In this section you will learn how to save and close the model.



Use following steps to create the Timing Chain Cover: 1. 2. 3. 4. 5.



Save and Close the Document.
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6.



Create a New Part. Select an Appropriate Sketch Support. Create Sketched Geometry. Constrain the Sketch. Create the Pad Feature.
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Saving Documents



Student Notes:



Documents need to be saved so that work is not lost. There are different ways to save CATIA documents: • • • •



Save Save As Save All Save Management



Documents are saved: • After modifying them. • To create new ones.



Documents can be saved:
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• With the same name (to replace the initial document). • Under a new name (to create a new document).
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Saving a Document with the Same Name



Student Notes:



Use one of the following methods to save a part with the same name in the same folder: A. Click File > Save. B. Select the Save icon from the Standard toolbar. C. Press the and keys simultaneously.



B



C
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Saving a Document with a New Name The Save As command is used to save an existing document under a new name. The Save As command creates copy of the existing document with a new name; it does not remove the original document. The first time a document is saved, CATIA will open the Save As dialog box regardless of which tool is used to save the document.



1



To save a part with a new name: 1. Click File > Save As. 2. From the Save As dialog box, browse to the directory where the file is to be saved. 3. Specify a name for the documents. 4. Select Save.
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Here, the document is stored in the same folder as the original with a new name.
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2



4 3
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Closing a Document When you are finished with the document you can close it. Use the following steps to close a document: 1. Click File > Close or select the Close icon. 2. If changes have been made but not saved, a dialog box asks you if you want to save changes. 3. Your options are: A. Select Yes to save the changes. B. Select No to close the document without saving the changes. C. Select Cancel to keep the document open.



1
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A



B



C
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To Sum Up



Student Notes:
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In the following slides you will find a summary of the topics covered in this lesson.
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Create a New Part



Student Notes:



When creating a new model, the Part Design workbench is activated. When a part is saved, it is saved with a.CATPart extension to distinguish it from other CATIA documents. Use the following method to create a new part file: Click Start > Mechanical Design > Part design. Click File > New and select Part from the New dialog box. Select the New icon from the Standard toolbar and select Part from the New dialog box.
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A new part contains only three default reference planes. These default reference planes are always the first elements in the specification tree and are used as a basis for feature creation.
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Select an Appropriate Sketch Support Every new part begins with a 2D profile. This profile can be created using the Sketcher workbench. The elements created within Sketcher are exclusively 2D WIREFRAME elements. In the Part Design workbench, the geometry created in Sketcher is seen as a single sketch. This sketch is used to create 3D features inside the Part Design workbench.



Sketch Sketches can be extruded to create solid geometry.
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A sketch support is the plane on which the sketch is created. The sketch support must be planar. You can create a sketch on a reference plane or on a planar face of any existing geometry. The default orientation of the model depends on which reference plane is selected for the sketch support.



Sketch support
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Create Sketched Geometry The Sketcher workbench is an environment built to facilitate the creation of the 2D Profiles. The Sketcher workbench includes:



D C



A. The Grid, which guides you while you create the profiles. B. The Profile toolbar, which is used to create geometry. C. The Constraint toolbar, which is used to constrain your sketch.



B A



D. The Sketch Tools toolbar, that displays options available during geometry creation.
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It is recommended to use a Positioned Sketch while creating a sketched profile. Do not to use Fillets, Chamfers and Drafts when creating sketched profile, because some of the manufacturing processes need to remove the Dress-Up features.
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Constrain the Sketch Constraints serve to mathematically fix geometry in space. Two types of constraints can be added to sketched geometry: A. Geometric constraints, which specify how sketched elements are positioned with respect to



A



each other and existing 3D geometry. B. Dimensional constraints, which specify the distance between two elements. This distance can be linear, angular, or radial.



B



Ideally, a completed sketch must be fully constrained. As you begin to create geometry, try to create it reasonably close in shape and size to the
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final constrained sketch.
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Create the Pad Feature Once the sketched profile has been created, solid 3D geometry can be generated from it. A pad is a sketch-based feature that adds material to a model.



Save and Close the Document Documents need to be saved so that work is not lost. There are different ways to save CATIA documents:



2D Profile (sketch)



Extruded Pad



Save Save As Save All Save Management Documents are saved: After modifying them. After creating new ones.
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Documents can be saved: With the same name (to replace the initial document). With a new name (to create a new document).
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Sketcher Tools Sketcher 1



Sketch: creates a new sketch and opens sketcher workbench 1



2



Positioned Sketch: creates a new sketch and you can specify various parameter for sketch support



2



Sketch Tools 3



Grid: a grid is applied to the background of the Sketcher workbench



4



Snap to Point: the mouse pointer snaps to the points of the grid



3



5



User-Defined Profile: creates a sketched element as a construction element



4 5
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6



Geometrical Constraints: controls whether geometric constraints are automatically created or not, during the development of the initial sketch
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Geometry Creation Tools Profile 1



User-Defined Profile: creates complex profiles consisting of straight line and circular arcs



2



Pre-defined Profiles: creates predefined profiles such as rectangle, parallelogram, hexagon etc.



1



Circles: creates circles and circular arcs



4



3



2 3



5



Splines: creates splines and connecting curves



6



5



Ellipses and Parabolas: creates conic curves such as ellipse, parabola, hyperbola etc.



7



6



Lines: creates predefined profiles such as rectangle, parallelogram, hexagon etc.



7



Points: creates splines and connecting curves
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Additional Tools Operation 1



2



Corner: creates a corner shape between the two selected lines.



1 2



Chamfer: creates a chamfer between the two selected lines.



Constraint 3



Constraint Defined in Dialog Box: creates geometrical constraints on selected elements.



4



Constraint: creates geometrical and dimensional constraints.



3 4



Sketch-Based Features
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5



Pad: extrudes a profile sketched in the Sketcher workbench. This command is available in Part Design workbench.



5



Standard 6



Save: saves recent changes done in existing files and saves newly created files.
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Exercise: Sketch Constraints



Student Notes:



Recap Exercise 15 min



In this exercise, you will construct various geometrical elements in the Sketcher workbench. This exercise will help you to understand how to constrain and dimension these sketched entities. Detailed instructions for this exercise are provided. By the end of this exercise you will be able to: Constrain a sketch Dimension a sketch
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Save and close a model
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Do it Yourself (1/10) 1. Create a new part. To begin modeling, create a new part and save it using the Save option. a. Select File > New. b. Choose Part from the New dialog box. c. Click OK. d. Change the filename to [Exercise_2d]. e. Click OK.



1d



1b 1e



2. Open the Sketcher workbench. Sketches are created in the Sketcher workbench. It is accessed by clicking the Positioned Sketch icon. a. Select XY Plane as the sketch support. b. Select the Part origin as the Origin. c. Select Y Axis as the Orientation.



1c



2



2a 2b
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2c
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Do it Yourself (2/10) 3. Turn on Automatic constraints Constraints were turned off in an earlier exercise to concentrate on using the sketching tools. By default, the Geometric and Dimensional constraint icons are active.



3a



a. Ensure both Geometrical Constraints and Dimensional Constraints are highlighted. If they are not, click the icons to activate the options.



4. Sketch a profile. To begin the sketch, create a profile using the profile tool that is the general shape and size the final sketch will be.
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a. b. c. d. e. f.



Select the Profile icon. Click a point to define the starting point. Draw a horizontal line. Select the Tangent Arc icon. Create the arc shown. The profile tool will default back to Line. Create another horizontal line. g. Create the vertical line. 4d h. Create the third horizontal line. i. Complete the profile by adding a line that connects the start point of the profile.
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Ensure Geometrical and Dimensional constraints are highlighted, as shown.



4a



4h 4f



4g 4i



4e 4c



4b
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Do it Yourself (3/10) 5. Create the overall horizontal dimension. Create the overall horizontal dimension for the created profile using the Constraint tool.



5a



a. Select the Constraint icon. b. Select the line segment c. Drag the mouse to place the dimension. Click to complete the dimension. d. Double-click the dimension. e. Modify the value to [340].



5b



f. Click OK to close the dialog box and update the dimension.
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5f
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Do it Yourself (4/10) 6. Create a diameter dimension. Dimension the arc using the constraint tool and change the dimension type to Diameter. a. b. c. d. e. f.



Select the Constraint icon. Select the arc. Drag the mouse to place the dimension. Click to complete the dimension. Double-click the value and change its value to [25]. Select the Dimension menu and change the option from Radius to Diameter.



6a



6b



Click OK to update the dimension. 6c



6d



6f
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Do it Yourself (5/10) 7. Create a vertical dimension. Create the overall vertical length of the profile using the constraint tool.



7a



a. b. c. d.



Select the Constraint icon. Select the top horizontal line. Select the bottom horizontal line. Drag the mouse to place the dimension and click to complete it. e. Double-click the dimension and type [85].



7b



7c
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Do it Yourself (6/10) 8. Create a horizontal dimension. Create the top horizontal dimension using the Constraint tool. a. b. c.



d.



Select the Constraint icon. Select the top horizontal line. Drag the mouse to the place the dimension and click to complete its placement. Double-click the dimension and change its value to [100].



8a



8b
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8c
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Do it Yourself (7/10) 9. Create an angular dimension. Create an angular dimension between the bottom horizontal line and the adjacent line using the constraint tool. a. b. c. d. e.



9a



Click the Constraint icon. Select the angled line Select the bottom horizontal line. Place the dimension. Edit the angular value to [30] degrees.



9b
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9c
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Do it Yourself (8/10) 10. Create a horizontal constraint. Constrain a line horizontally using the Constraints Defined in Dialog Box tool. a. Select the horizontal line. b. Select the Constraints Defined in Dialog box icon. c. Select the Horizontal option in the Constraint Definition dialog box.



10a



d. Click OK to apply the constraint to the sketch. 10b
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10c
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10d
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CATIA V5 Automotive - Powertrain Lesson 2: Profile Creation Student Notes:



Do it Yourself (9/10) 11. Create a circle and constrain it. Create a circle using the Circle tool. Constrain Its center to the center of the arc using the Constraints Defined in Dialog Box tool. a. Sketch a circle. b. Select the center point of the arc. Press and hold the key and select the center of the circle. c. Click the Constraints Defined in Dialog Box icon. d. Select the Coincidence option.



11a



e. Click OK to apply the constraint.



11d
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11b
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Select both the center point of the arc and the circle. 11e



11c
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CATIA V5 Automotive - Powertrain Lesson 2: Profile Creation Student Notes:



Do it Yourself (10/10) 12. Verify the coincidence constraint. Move the center of the circle and ensure that it does not move on its own. If the circle can move without moving the entire sketch, it indicates that the sketch is not constrained properly. 12a



12c
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a. Select the center of the point of the arc and circle. b. Press and hold the left mouse button, and try moving the point to the left or right. The entire sketch should move. c. Select the Coincidence constraint and press the key. d. Select the center of the circle and now try to move it. Only the circle should move. e. Delete the sketched circle.
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CATIA V5 Automotive - Powertrain Lesson 2: Profile Creation



Exercise Recap: Sketch Constraints



Student Notes:



Constrain a sketch
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Dimension a sketch
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CATIA V5 Automotive - Powertrain Lesson 2: Profile Creation



Exercise: Sketch Constraints



Student Notes:



Recap Exercise 15 min



In this exercise, you will fully constrain an existing sketch using the tools from the previous exercise. This exercise will help you understand how to constrain and dimension sketched entities. High-level instructions for this exercise are provided. By the end of this exercise you will be able to: Load an existing document Constrain a sketch Dimension a sketch Use problem-solving skills
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Save and close a model CAUTION: Generally, for complex parts it is recommended that you simplify the sketches using dedicated 3D features like fillets, chamfers, holes, drafts, etc. to better fit the design and manufacturing intents.
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CATIA V5 Automotive - Powertrain Lesson 2: Profile Creation Student Notes:



Do it Yourself (1/5) 1.



Load the file. Load Ex2E_1.CATPart. Once loaded, notice that sketches have already been created for you.



2.



Edit the sketch. Modify the sketch.1 in the Sketcher workbench by double-clicking on the sketch directly in the model or in the specification tree.



3.



Add Horizontal constraints.



3



3
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3
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CATIA V5 Automotive - Powertrain Lesson 2: Profile Creation Student Notes:



Do it Yourself (2/5) 4.



Add Tangency constraint. Apply a tangency constraint between the bottom horizontal line and the arc.



5.



Remove coincidence constraints which are not required.



5
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CATIA V5 Automotive - Powertrain Lesson 2: Profile Creation Student Notes:



Do it Yourself (3/5) Add dimensional constraints. Using proper techniques, add dimensional constraints to the sketch. Once all the dimensional constraints have been applied, the sketch will turn green, indicating that the sketch is fully-constrained.



6
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6.



Copyright DASSAULT SYSTEMES



2-102



CATIA V5 Automotive - Powertrain Lesson 2: Profile Creation Student Notes:



Do it Yourself (4/5) 7. Edit the sketch. Modify the sketch.2 in the Sketcher workbench by double-clicking on the sketch directly in the model or in the specification tree.



8



8. Sketch in Context. Project the edge of sketch.1 and keep it as a construction element. Add Concentricity constraint. 9. Add dimensional constraint. Add 20mm diameter dimension to make sketch.2 fully-constrained.



9
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10. Add dimensional constraint. Similarly, make sketch.3 fully-constrained.
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CATIA V5 Automotive - Powertrain Lesson 2: Profile Creation Student Notes:



Do it Yourself (5/5) 11. Search and Load Ex2E_2.CATPart. Load an existing part file. Once loaded, notice that sketches have already been created for you.



11



12. Edit the sketch. Modify the sketches in the Sketcher workbench by double-clicking on the sketch directly in the model or in the specification tree.
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13. Geometrically and dimensionally constrain the sketches. Fully constrain the sketched circles with 20mm diameter dimensions as in the earlier instance.



13



13



13



14. Compare sketches. Were the sketches easier to constrain compared to the earlier instance? Why? 15. Save and close both the documents.
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CATIA V5 Automotive - Powertrain Lesson 2: Profile Creation Student Notes:



Exercise Recap: Sketch Constraints



Constrain the sketches
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Dimension the sketches
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Understand proper sketching techniques
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CATIA V5 Automotive - Powertrain Lesson 2: Profile Creation



Exercise: Sketch Constraints



Student Notes:



Recap Exercise 15 min



In this exercise you will fully constrain an existing sketch. You will use the tools learned in this lesson to complete the exercise with no detailed instructions. By the end of the exercise you will be able to: Open an existing model Edit a sketch Constrain an existing sketched geometry
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Save and close the document



CAUTION: Generally, for complex parts it is recommended that you simplify the sketches using dedicated 3D features like fillets, chamfers, holes, drafts, etc. to better fit the design and manufacturing intents.



Copyright DASSAULT SYSTEMES



2-106



CATIA V5 Automotive - Powertrain Lesson 2: Profile Creation



Do it Yourself Load Ex_2F.CATPart and fully constrain the sketch.
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1.



Student Notes:
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CATIA V5 Automotive - Powertrain Lesson 2: Profile Creation



Exercise Recap: Sketch Constraints



Student Notes:



Constrain a sketch
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Dimension a sketch
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CATIA V5 Automotive - Powertrain Lesson 2: Profile Creation



Case Study: Profile Creation



Student Notes:



Recap Exercise 10 min



In this exercise you will create the case study model. Let us recall the design intent of this model: The model must be created in one feature. The top angle must be 120 degree. The overall height must be 335mm. The angular side walls must be perpendicular to the top walls. The thickness must be 12mm.
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The center of convex circular arc must be 50mm from vertical reference and 120mm from horizontal reference.



Using the techniques you have learned so far, create the model without detailed instructions.
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CATIA V5 Automotive - Powertrain Lesson 2: Profile Creation



Do It Yourself: Drawing of the Timing Chain Cover



Student Notes:
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Create the model using the drawing provided here.
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CATIA V5 Automotive - Powertrain Lesson 2: Profile Creation



Case Study Recap: Timing Chain Cover



Student Notes:



Create a new part file Select the YZ plane as sketch support Create a sketch geometry Constrain the sketch according to design intent Create a pad feature
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Save and close the document
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